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Background 

DNA Replication 

 DNA replication is a crucial process through which a cell duplicates its genetic material 

to pass it to daughter cells. Proper control of the process is critical for cell viability. One of the 

most powerful points to implement control mechanisms on DNA replication is at the initiation 

stage. Initiation of DNA replication occurs at sites called origins of replication scattered 

throughout the genome. Complicated interactions between many different pieces of cellular 

machinery are a measure to ensure that each origin is activated at most once per cell cycle. In 

this manner, the amount of DNA in a single cell should be perfectly duplicated in each cell 

division, thus retaining a constant amount of DNA in the genome of each daughter cell. In typical 

replication, the pre-replicative complex (pre-RC) forms first. Pre-RC assembly begins with the 

multi-subunit origin recognition complex (ORC) binding to the origin. Proper placement of the 

ORC then recruits two additional factors, Cdc6 and Cdt1, which are both required to bring the 

Mcm2-7 helicase to the origin to complete pre-RC assembly and allow for initiation of DNA 

synthesis (Figure 1). With the helicase activation and recruitment of DNA polymerases, the 

replication fork moves away from the origin and the replication complex is disassembled 

(Aparicio, Weinstein et al. 1997). Several processes afterwards, including removal of both Cdc6 

and Cdt1, prevent reformation of the pre-RC and re-replication. 
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 Despite the many safeguards built into the mechanisms of replication initiation, there 

are a few cases where the regulatory measures are overcome and an origin activates more than 

once in a single cell cycle (Claycomb and Orr-Weaver 2005). This override of control leads to re-

replication events at the locus and DNA amplification, locus-specific accumulation of a greater 

than normal amounts of DNA. Defects in origin replication, particularly in the licensing step, 

have been associated with oncogene-induced cell proliferation. Misregulation leading to under- 

or over- replication of chromosomal DNA is also thought to be connected to the genetic 

instability common to cancer cells (Blow and Gillespie 2008). As such, understanding DNA 

amplification is very relevant to current medical interests. For example, if the characteristics and 

mechanisms of DNA amplification were understood, it could illuminate a new focal point for 

designing cancer therapeutics. 

 Studying rogue DNA re-replication is difficult with traditional systems because inducing 

re-replication in mitotic cells would cause them to exhibit harmful or fatal phenotypes. 

However, there are two organisms where re-replication occurs as part of their natural 

development process. These two systems are the chorion genes in the ovarian follicle cells of 

Drosophila melanogaster and the salivary glands of Sciara coprophila (Claycomb and Orr-

Figure 1. Model of DNA replication 

complexes: arrival and departure of 

different factors (Aparicio, Weinstein et al. 

1997) 
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Weaver 2005). DNA amplification in these two systems is not only natural but also site-specific, 

occurring in a setting where cis-regulatory sequences have been investigated, leaving trans-

activating replication factors open for examination (Claycomb, MacAlpine et al. 2002). These 

two instances of developmentally programmed re-replication are suitable systems for 

experiments to explore methods of overriding initiation control mechanisms. 

Sciara coprophila 

 Sciara coprophila is a lower Dipteran fungus gnat. Historically, Sciara competed with 

Drosophila melanogaster to be the leading model organism for genetics and developmental 

studies, but ultimately lost due to its high resistance to radiation, the most common method for 

inducing mutations at that time. Sciara has a simple life cycle with four main stages. Female 

adults lay eggs wherein embryos develop for seven to ten days before hatching into larvae. The 

larval stage lasts about three weeks, during which the larvae progress through four instars – 

stages demarcated by molting of the outer chitin cuticle. At the end of the fourth instar, the 

larvae become pupae and undergo total body remodeling; all larval tissue except for the 

nervous system and imaginal discs is destroyed. The imaginal discs then divide to create the 

adult tissue. Adults emerge after four days of pupation and survive for an additional week. 

 Sciara larvae undergo endoduplication, or repeated rounds of DNA replication without 

mitosis, which create polytene chromosomes. Intra-chromosomal DNA amplification at specific 

loci is superimposed on the last cycle of endoduplication, leading to the formation of nested 

replication forks in an onion-skin structure at the DNA puff loci. The progression of DNA puffs 

correlates with the development of the larvae. An informative physical characteristic to track 

the development of the larvae are their eyespots – pigmentation on the part of the brain that 

ultimately develops into the adult eyes. Eyespots are a useful index because their appearance 
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and growth at the end of the fourth larval instar correlates with specific stages of DNA puffing. A 

nomenclature system has been established using the number of pigment granules in the 

primary row and the number of secondary rows after the largest (Gabrusewycz-Garcia 1964). In 

this system, there are six main stages of eyespot progression: early eyespots (8x4 and less), 

10x5, 12x6, 14x7, edge eye, and dropped jaw (Figure 2). It takes about one day to move from 

one eyespot stage to the next. DNA endoduplication occurs from hatching until the 10x5 stage 

when DNA puff amplification begins. 

 
Figure 2. Diagram of morphological and eyespot development: a close up of the eyespots is included 

above larvae at each eyespot stage (Wu, Liang et al. 1993) 

Polytene Chromosomes 

 Polytene chromosomes are giant chromosomes that result from the synapsis of multiple 

sister chromatids and the pairing of the maternal and paternal homologous chromosomes. They 

form when DNA accumulates through endoduplication, which involves multiple rounds of DNA 

replication without division through mitosis. This phenomenon is observed in the tissues of 

many insects including, but not limited to, Dipteran flies such as Sciara and Drosophila. In Sciara, 

most larval tissues undergo some amount of reduplication but the salivary glands reach the 
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highest levels. In successive reduplication events, the DNA accumulates in a geometric 

progression. The salivary gland chromosomes complete about twelve rounds of additional 

replication, leading to 4,096 aligned sister chromatids, or 4,096c where c is the haploid DNA 

content; females experience an additional round of endoduplication, bringing their total to 

8,192c (Rasch 1970). 

 One of the most visibly apparent physical characteristics of the polytene chromosomes 

is the banding pattern. The bands result from higher order packing of the large volume of DNA 

present, such as variation in the extent of DNA coiling with its associated proteins like histone 

H1, which facilitates supercoiling (Jamrich, Greenleaf et al. 1977). Chromomeres are darker 

bands of compact DNA separated by interchromomeres, or lighter bands of less condensed 

DNA. Normal sized diploid chromosomes have alternating regions of chromatin compaction, but 

are generally too small to distinctly observe a banded appearance. On the other hand, individual 

sister chromatids in polytene chromosomes align, and each single band is magnified into a much 

larger and cohesive unit. The banding pattern is typically very stable and specific to each 

individual chromosome (Zhimulev and Koryakov 2009). It may be used to differentiate 

chromosomes and has also been used as a method of mapping genes.  

Sciara has three autosomes (II, III, and IV) and one X sex chromosome. Maps (Figure 3) 

have been compiled for the Sciara salivary gland polytene chromosomes, all across multiple 

stages of development except for the X Chr (Gabrusewycz-Garcia 1964). Each chromosome is 

divided into numerical zones loosely assigned on the basis of chromosomal lengths: 

chromosome II and the X chromosome have fourteen zones, chromosome III fifteen zones, and 

chromosome IV twenty. Each zone is further subdivided into three segments: A, B, and C. These 

segments are delimited by noticeable cytological features. Single bands may vary between 
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larvae and developmental stages, but these maps are particularly useful in locating prominent 

cytological features such as puffs or asynapsed regions. 

 
 

 
 

 
 

 
Figure 3. Maps of Sciara salivary gland polytene chromosomes: top depicts maximal development of large 

DNA puffs and the bottom the first signs of puffing; the X chromosome has only been mapped in one 

stage (Liew, Foulk et al. 2013) 

 In some cases, the polytene structure of concentrated DNA can be opened up by 

massive amounts of synthetic activity, such as transcription. The visual morphological change 

from this anabolic burst is the decompaction of DNA and appearance of a puff of nucleic acid 

material radiating out from that specific locus (Figure 4). Both Sciara and Drosophila polytene 

II 

III 

IV 

X 



7 
 

chromosomes have RNA puffs that are indicative of high levels of transcription at those loci. 

However, only Sciara has DNA puffs at loci that undergo re-replication to become amplified. Puff 

structures often appear more transparent and have a more lightly stained appearance due to 

the decrease in DNA concentration from the increase volume of the puff structure. 

 

DNA & RNA Puffing 

 In Sciara, additional DNA puff amplification is superimposed on the last round of 

endoduplication of the salivary gland polytene chromosomes. DNA puffs are locations of intra-

chromosomal DNA amplification involving the reactivation of an origin in a single cell cycle and 

an accumulation of replication forks as well as multiple copies of the same DNA. The onion skin 

model (Figure 5) has been proposed and substantiated by electron microscope visualization of 

Miller spreads of chromatin as the mechanism of DNA amplification in Drosophila and Sciara. Bi-

directional replication forks are layered upon each other through the successive firing of a single 

origin (Claycomb and Orr-Weaver 2005). DNA replication during this form of amplification uses 

the same previously identified initiation factors, such as ORC, Cdt, and Mcm2-7, that typically 

license and activate replication origins (Tower 2004). DNA puff amplification reaches very 

Figure 4. Phase microscope image of 

Sciara salivary gland polytene 

chromosome II: DNA puff II/9A (black), 

DNA puff II/2B (red), RNA puff II/1B (blue) 
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significant levels, where the puff can account for about 10% of the total nuclear DNA (Rasch 

1970). 

                    

 Puff amplification and the resulting increase of DNA template is thought to be a 

mechanism of gene amplification to create high demand proteins during certain developmental 

stages. In Sciara, the DNA puffs lead to the increased production of structural proteins that the 

larvae need at the end of the fourth instar in order to construct their pupal cases (Claycomb and 

Orr-Weaver 2005). This application also allows Sciara to avoid the pathological repercussions of 

extra DNA because the salivary gland tissue is discarded quickly thereafter through pupal 

remodeling. In addition, Sciara DNA puff amplification is the only system where a direct trigger 

for DNA amplification has been identified and shown to be a steroid hormone (Foulk, Liang et al. 

2006). Studying the mechanism of how a hormone overrides the normal genomic controls 

against re-replication may provide a paradigm for hormonally sensitive cancers, such as breast 

or prostate cancer. 

 In addition to DNA puffs, Sciara also exhibit smaller RNA puffs (Figure 4). RNA puffs are 

much more widely prevalent in insects, having been observed in both Drosophila and 

Chironomus. They are morphologically similar where the presence of transcription machinery 

Figure 5. Onion skin model of re-replication: 
nested replication forks from repeated 
origin firing 

 



9 
 

opens the formerly compact chromatin structure, but are not as large as Sciara DNA puffs 

because they typically involve a smaller number of bands. In Drosophila immunolocalization 

experiments, RNA polymerase B was found almost exclusively in interchromomeres and RNA 

puffs, suggesting that these areas contain active genes (Jamrich, Greenleaf et al. 1977). Outside 

of developmental signals, heat shock and other environmental stimuli are able to produce a 

characteristic puff response (Simon, Sutton et al. 1985). Unlike DNA puffs, some RNA puffs in 

Sciara are not as constrained to specific times of appearance or durations (Gabrusewycz-Garcia 

1964). 

 The locations of both DNA and RNA puffs has been documented in late larval Sciara 

salivary gland chromosomes (Table 1). There are ten major and eight minor DNA puffs, 

distinguished by their size (Gabrusewycz-Garcia 1964, Gabrusewycz-Garcia 1971). DNA puff 

II/9A located on chromosome II is the largest puff (Figure 4). It is amplified approximately 16-

fold (Wu, Liang et al. 1993). Puff II/9A is the only puff that has been studied extensively 

previously. Differences in puffing pattern between the anterior and posterior sections of the 

salivary gland has also been noted. RNA puffs are much smaller than DNA puffs and not much 

research has yet been done focused specifically on the Sciara RNA puffs. In fact, it is unknown if 

all RNA puff loci have been identified. 

Table 1. DNA and RNA puffs: major DNA puffs are bold typeface; puffs that specifically appear in the 

anterior (ant) and posterior (post) parts of the salivary gland are also noted (Liew, Foulk et al. 2013) 

Chr DNA puffs RNA puffs 

II 2B, 6A, 9A, 11A (post), 13A, 14B (post) 1B, 10B/C, 12A, 12B, 13C 

III 2B (ant), 10A, 11A, 15B (ant) 4A, 5C, 7A, 9B, 12C 

IV 5C, 8C, 12A (ant), 15B (post), 19A 4C, 5B, 6B, 7B, 9C, 10A, 10C, 19C 

X 7A, 11B 4A, 4B, 8B, 13B, 14B, 14C, 15A, 15B, 16C, 17B 
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Puffing, Replication & Transcription 

 Ecdysone is a steroid hormone commonly regarded as the master regulator of insect 

development, but is also being increasingly understood as a regulator of DNA puff gene 

expression. Ecdysone is known to induce RNA puffing in Drosophila. In Sciara, ecdysone induces 

the morphological appearance of DNA puffs (Crouse 1968) and also DNA amplification, 

specifically at DNA puff II/9A (Foulk, Liang et al. 2006). This brings a new replication-related 

dimension of ecdysone up for consideration, where previously ecdysone was understood to 

regulate only transcription in Drosophila. However in the re-replication systems, not all genes in 

the amplicons are highly expressed and there are still many highly expressed genes outside of 

puffs (Kim, Nordman et al. 2011). The relationship between replication and transcription at puff 

loci is still not completely understood. Three major questions stand out: are amplified genes 

highly transcribed? Are highly transcribed genes amplified? When does active transcription 

occur with respect to DNA amplification?  

 A large body of work has been done to investigate the relationship between 

transcription and the phenomenon of puffing. In Drosophila salivary glands, research has shown 

that the natural puffing of the locus of two glue protein genes, Sgs-4 and Sgs-3, can be 

uncoupled from abundant expression of the genes. Deletion of the promotor region required for 

puff formation prevents the appearance of the puff but does not significantly effect protein 

production (Crosby and Meyerowitz 1986, McNabb and Beckendorf 1986). Conversely, a 

transduced puff promoter region is able to create a puff structure by itself without significant 

transcriptional activity at the locus (Korge, Heide et al. 1990). Although these studies 

demonstrate that morphological puffing and transcription can be uncoupled, usually the degree 

of puff expansion and transcription are generally correlated (Simon, Sutton et al. 1985). 

Additionally, the expansion of DNA puffs in Sciara correlates more closely with increased RNA 
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synthesis rather than local DNA amplification for the major DNA puffs II/9A and II/2B 

(Gabrusewycz-Garcia 1971, Wu, Liang et al. 1993). 

 

DNA puff formation is usually correlated with the abundant expression of the genes 

contained in the puff (Simon, Siviero et al. 2016). However, the temporal relationship between 

amplification and transcription occurrence is still in question. Abundant DNA template is 

required for bulk RNA synthesis, but transcription could be a method of opening the 

chromosome structure to allow for amplification. In DNA puff II/9A of Sciara, DNA amplification 

precedes transcription, and morphological puffing correlates with the time of transcription at 

the DNA puff loci (Wu, Liang et al. 1993). Southern and Northern blot analysis of puff II/9A 

showed that amplification began at an earlier developmental stage and reached a plateau by 

the time the burst of transcription was observed (Figure 6). While puffing seems to coincide 

with transcription, there are inhibitor studies that show maintenance of the expanded puff 

structure is independent of active RNA or DNA synthesis (Mok, Smith et al. 2000). Furthermore, 

also at the II/9A locus, ecdysone response element (EcRE) was discovered adjacent to the ORC-

binding site in the origin and at the promoter for each of two genes further downstream. This 

Figure 6. DNA amplification 

and RNA transcription over 

developmental time: relative 

measurements from 

Northern and Southern blots 

(Gerbi, Liang et al. 1993) 
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would implicate ecdysone as promoting initiation of amplification at the origin first and then 

secondarily inducing transcription from the promoter after replication is completed. 

Interestingly, inactive RNA polymerase II is also loaded at the gene II/9-1 promoter during 

amplification of the II/9A locus (Lunyak, Ezrokhi et al. 2002); this could be a method of loosening 

the chromatin structure and enabling re-replication through the mere presence of transcription 

machinery. One hypothesis is that the ecdysone receptor could recruit the inactive RNA 

polymerase to the site (Liew, Foulk et al. 2013). 

 These studies into the relationship between amplification and transcription all mainly 

focus on II/9A; there is a wealth of information still undiscovered about the seventeen other 

DNA puff loci. Initial steps towards a global approach using immunofluorescence with an 

antibody specific to an isoform of the Sciara ecdysone receptor (EcR-A) suggest a genome-wide 

role for ecdysone in regulating DNA amplification (Foulk, Waggener et al. 2013, Liew, Foulk et al. 

2013). EcR-A has similar timing previously seen with puff II/9A genome-wide, binding just as 

amplification begins. This is consistent with ecdysone being directly related to DNA re-

replication. However, this hypothesis remains to be tested by molecular genetic ablation of the 

origin EcRE. The present study aims to investigate the transcription profiles of larvae at different 

developmental stages to determine whether they follow the same model as II/9A of 

amplification preceding transcription. Mapping transcription should also be able to identify 

regions of the greatest rates of transcription and see to what extent they coincide with puffs, 

shedding some light on whether amplified genes are highly transcribed and vice versa. 

Extending previous mappings of RNA puff locations would enable sequence comparison 

between RNA and DNA puff loci to identify features that may specifically lead to re-replication. 
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Investigating RNA Transcription 

 Pulse-chase methods have commonly been used to measure rates of transcription in 

cells: a cell is allowed to incorporate a labeled moiety for a defined period of time and 

afterwards the amount of uptake can be visualized. Throughout history this method has 

continued to be implemented, only with different metabolites and labeling techniques. Two 

classic methods are labeling with radioactive nucleosides, such as tritiated uridine, with 

visualization through autoradiography and incorporation of 5-bromouridine (BrU) measured by 

immunostaining. RNA metabolism in Sciara salivary gland nuclei has been previously studied 

through tritiated uridine autoradiography (Gabrusewycz-Garcia and Kleinfeld 1966). 

Disadvantages to this method are that autoradiography is slow and image resolution is typically 

poor. BrU labeling is also limited since the visualization step is inherently restricted by the 

antibody. 

 A new generation of reactants for labeling and detecting RNA synthesis has risen with 

greater resolving power and leveraging biorthogonal chemical reactions. A specific set of 

reactions known as “click chemistry” has particularly garnered attention as a biocompatible 

tagging method. These reactions are fast, specific, high yield with minimal byproducts, and can 

easily occur at physiological conditions (Kolb, Finn et al. 2001). All of these characteristics make 

them ideal for selective labeling of biomolecules. For RNA transcription, the copper(I)-catalyzed 

azide-alkyne cycloaddition (CuACC) has been leveraged to visualize the incorporation of 5-

ethynyl uridine (EU) as a uridine analog (Jao and Salic 2008, Rieder and Luedtke 2014). EU is 

incorporated efficiently by RNA polymerases I, II, and III. Sites of EU incorporation are then 

exposed to an azide moiety attached to a fluorophore. In the presence of copper(I), the alkyne 

group on the uridine reacts with the azide, attaching the fluorophore to the site through a 

strong covalent bond (Figure 7). This interaction is much more sensitive than immunostaining, 
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making EU detection more sensitive than BrU. Additional advantages to this method are that the 

reactants are small, meaning that permeability is not a limiting factor, and the covalent 

interaction is strong enough to not be affected by affinity issues or chromosome structure as 

much as intercalating dyes or antibodies (Ishizuka, Liu et al. 2016). The present study uses the 

Click-iT™ RNA Alexa Fluor(TM) 594 Imaging Kit developed by Invitrogen (Thermo Fisher 

Scientific). 

             

  

  

Figure 7. Copper(I)-catalyzed azide-alkyne cycloaddition: click reaction between 5-ethynyl uridine and the 

fluorophore-azide 
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Methods & Materials 

Preparation of Slides & Coverslips 

1. Sonicate out-of-the-box Corning microscope slides in Milli-Q ultrapure water and powdered 

labware detergent for 60 minutes (two rounds of 30 minutes). The sonicator can fit six slide 

beds (of 10 slides) at a time. 

2. Rinse slides for at least 30 minutes under running hot tap water (rinse in autoclave overflow 

container propped up over the drain). 

3. Rinse slides for at least 30 minutes under running deionized water. 

4. Dunk slides in a staining dish of Milli-Q ultrapure water for final rinse. When dunking slides in 

staining dishes, refresh staining dish solution every three slide beds. 

5. Dunk slides in a staining dish with 95% ethanol twice (two separate staining dishes). 

6. Allow slides to air dry in the slide beds overnight. Keep slide beds covered to protect from 

dust. 

7. Wash slides in staining dishes with 1:10 dilution (1:1 mix of 1:10 dilutions in PBS and water) of 

poly-L-lysine (0.1% w/v stock) for around 15 minutes (up to an hour). Poly-lysine dilutions should 

be stored at   -20°C and only the amount necessary should be poured out at a time. Warm the 

solution in the microwave before use. 

8. Allow slides to air dry in the slide beds covered (with tinfoil, etc.) to prevent dust from 

sticking. Drying may take as long as overnight. 

9. Soak 22x22mm coverslips in RainX for at least 2 minutes to siliconize them. 

10. Allow coverslips to air dry on wooden rack. 

11. Polish siliconized coverslips with a Kimwipe before use. 

Eyespot Staging 

1. Obtain a plastic tray and metal (heating) block. Put the block in the tray and fill the tray with 
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ice around the block. 

2. Under the dissecting microscope, transfer the larva to be staged onto a microscope slide with 

several drops of distilled water. 

3. Through the microscope, ensure that the larva is oriented such that its eyespots are facing up, 

and then gently place a coverslip over the larva. There should be enough water underneath the 

coverslip such that the larva is not completely squished, but also not too much so that the larva 

is able to move freely. It may be necessary to blot extra water away with a Kimwipe next to the 

coverslip. 

4. Place the slide with the larva on the block of ice for around 5 minutes. This is to reduce the 

movement of the larva to make counting the eyespots possible. If the larva is still moving, return 

it to the ice for more time. 

5. Under the phase microscope (Zeiss Neofluar Ph 2 16/0.40), count the number of eyespots in 

the largest row and also count the number of distinct rows. To classify larvae, use the number in 

the largest row x the number of rows minus 1 (e.g. 14x7 has 14 eyespots in the largest row and 

8 rows of eyespots). The main classifications are 8x4, 10x5, 12x6 and 14x7. Also keep in mind 

that if the eyespots are uncountable, the larva may be in the Early Eyespot Stage (EES), Edge Eye 

(EE), or Drop Jaw (DJ) stages. 

6. Note down the eyespot stage of the larvae. If a larva does not fit into the typical 

categorizations such as 11x5, for grouping purposes count that larvae as belonging into the next 

group up (e.g. 11x5 count as 12x6, but make sure to note this distinction). 

Chromosome Squash (and EU incubation) 

Note: the volumes in this protocol are suitable for four slides per experiment 

1. Thaw an aliquot of 100mM EU (Component A) in an ice bucket. Then add 4.5μL of 100mM EU 

to 145.5μL Cannon’s medium (3mM EU final concentration) in an Eppendorf tube. Keep tube 
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covered in an ice bucket when not in use (return aliquot to freezer). 

2. Use a razor blade to gently remove the coverslip floating on top of the larva. With forceps, 

move the larva into a drop of Cannon’s medium (Cannon 1964) on a siliconized microscope 

slide. 

3. Dissect the salivary glands from the larva. Make sure to keep the glands attached to the brain 

while removing as much fat body as possible. Attachment to the brain is necessary for puff 

induction and maintenance (Wu, Liang et al. 1993). 

4. Put 35μL of the EU solution in a well of a depression slide, then transfer the dissected glands 

into the drop of solution. 

5. Incubate the glands in a dark humid chamber (plastic chamber with wet filter paper at 

bottom, wrapped in aluminum foil) for 60 minutes at room temperature. If processing multiple 

larvae, keep track of the incubation time for each pair of salivary glands individually and stagger 

the incubations while doing squashes to ensure that each pair of glands is incubating for as close 

to 60 minutes as possible. 

6. Make (or if already made, heat – can keep for a week at a time) 37% formaldehyde solution in 

15mM KOH by adding 1mL 15mM KOH to 0.37g powdered paraformaldehyde in an Eppendorf 

tube. Boil until dissolved. 15mM KOH can be made in bulk and kept on the side as a stock 

solution. 

7. Make Solution 1 and Solution II fresh daily in Eppendorf tubes: 

 a. Solution I (Total Volume = 250μL):   Final Concentration 

   i. 197.5μL distilled H2O 

   ii. 25μL 10X PBS (pH 7.4)    1X 

   iii. 25μL 37% formaldehyde    3.7% 

   iv. 2.5μL Triton X-100     1% 
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  b. Solution II (Total Volume = 250μL):   Final Concentration 

   i. 100μL distilled H2O 

   ii. 125μL acetic acid     50% 

   iii. 25μL 37% formaldehyde    3.7% 

8. Put 35μL Solution I on one side of an untreated slide and 35μL Solution II on the center of a 

22x22mm siliconized cover slip placed next to the other drop of solution on the slide. Do not re-

use siliconized cover slips. 

9. Transfer glands from the depression slide to the drop of Solution I on the untreated slide and 

let sit for 25 seconds. 

10. Transfer glands from Solution I to Solution II and let sit for 70 seconds. 

11. Place a poly-lysine microscope slide on top of the salivary glands such that the two slides are 

parallel and only intersect over where the prep is. The solution should fill the area of the 

coverslip and let it stick to the poly-lysine slide when picking it up and flipping the slide over 

such that the coverslip is facing upwards again. Throughout all of this, try to keep the salivary 

glands centered on the coverslip. 

12. Blot excess liquid that escaped from under the coverslip with a Kimwipe. 

13. With a pencil eraser, gently nudge (not really pressing down, but should feel very slight 

resistance) the coverslip to move it around the slide. The goal of this movement is to move the 

chromosomes out of the nuclear envelope and outside the cellular membrane. Check under the 

phase microscope to see if the chromosomes have successfully escaped. 

14. Tap the eraser lightly over the prep to squash, holding the pencil horizontally. The first round 

of tapping should gentle, trying to separate chromosomes but not stretching them out. The 

second round can tap more vigorously (still trying to not move the coverslip at all). Periodically 

check the progress of the squash using the phase microscope. Tapping in a spiral in from the 
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edge can help chromosomes move back towards the middle. Also, tap in specific locations 

identified through the microscope that particularly need more spreading. 

15. When the chromosomes are satisfactorily spread (not balled up but not in pieces, banding 

pattern is viewable, etc.), place the prep in a folder of absorbent paper with the coverslip in the 

middle. Place a wooden block on top of the folder positioned over the slide and press down 

forcefully on the block and the table to squash the prep. Avoid any sort of rotation of the block 

on the slide (only use downward force). 

16. Submerge the prep-site on the slide in liquid nitrogen and hold it there 15 seconds after it 

stops bubbling. 

17. Immediately flip off the coverslip with a razor blade. Use a diamond pen to score where the 

corners of the coverslip used to be to mark the position of the prep. Also label the slide for note 

taking purposes. 

18. Let the slide wash in PBS in a Coplin jar until the other squashes are finished. The Coplin jar 

should be wrapped in foil and slides kept dark at all time. 

Click-iT™ RNA Labeling 

Invitrogen by Thermo Fisher Scientific Click-iT™ RNA Alexa Fluor(TM) 594 Imaging Kit 

1. Wash all slides while gently shaking twice for 10 minutes, replacing the solution for each 

wash.  

2. Make reaction cocktail (125μL total volume) in an Eppendorf tube: 

Note: the reaction buffer additive and Alexa Fluor will need to be thawed before use 

 a. 11.25μL distilled H2O 

  b. 1.25μL reaction buffer additive (Component E) 

  c. 107μL reaction buffer (Component C) 

  d. 5μL copper sulfate (Component D) 
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  e. 0.5μL Alexa Fluor (Component B) 

3. Wipe the slides, avoiding the actual prep, and shake (flick of the wrist) dry. Then add 30μL of 

reaction cocktail to each slide. Cover with a 22x22mm coverslip and try to avoid air bubbles. 

4. Incubate for 30 minutes in a dark humid chamber at room temperature. 

5. Rinse off coverslips in PBS and quickly wipe and shake dry before adding 60μL of rinse buffer 

(Component F) to each slide. Cover with a 22x22mm coverslip and try to avoid air bubbles. 

6. Incubate for 5 minutes in a dark humid chamber at room temperature. 

7. Rinse off coverslips in PBS then replace the solution and wash while gently shaking twice for 

10 minutes. 

8. Wipe and shake dry the slides. Then add 20μL of DAPI (1:1,000 dilution). Cover with a 

22x22mm cover slip and try to avoid air bubbles. 

9. Let sit for 7 minutes in the dark at room temperature. 

10. Rinse off coverslips in PBS then replace the solution and wash while gently shaking for 5 

minutes. 

11. Wipe and shake dry the slides. Then add 16μL of Prolong Gold/Diamond mounting media. 

Cover with a 22x22mm coverslip while avoiding air bubbles. Let the media set overnight at 4°C 

in the dark. Allow slides to warm up in room temperature for 10 minutes before viewing. 

Materials 

Poly-L-Lysine Solution (1:10 dilution in 1:1 mix of water and PBS) 

Add 30mL poly-L-Lys solution (Sigma #P8920) and 30mL tissue culture PBS (pH range 7.2-7.6) to 

250mL water to prepare 300mL of poly-L-Lys working solution. This should be done in a plastic 

beaker and graduated cylinder since poly-Lys sticks to glass. 

The poly-L-Lys solution can be stored at 4°C after sterilization, or -20°C without sterilization at 

least for at least 4 months. 
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PBS (Phosphate-buffered Saline) 

Make large batches of 10x PBS to dilute into 1x PBS working solutions. 

10x PBS: 80g NaCl, 2g KCl, 14.4g Na2HPO4, and 2.4g KH2PO4 in 1L distilled water, pH adjusted to 

7.4 

10x PBS to 1x PBS is a ten-fold dilution (e.g. 50 mL 10x PBS with 450mL sterile water). 

1x PBS is 137mM NaCl, 2.7mM KCl, 10mM Na2HPO4, and 1.8mM KH2PO4 at pH 7.4. 

DAPI Stain 

Dye stock solution: 2.5mg/mL in distilled water 

Working solution stock: 0.25μg/mL (1:10,000 dilution) 

Make a 1:1,000 dilution from the dye stock solution by taking 3μL of the stock and putting it into 

3mL of PBS. Mix this solution well by vortexing. This aliquot is a 10x stock that can be stored and 

conveniently accessed. 

To make a working solution, take 100μL of the 10x stock and put it into 900μL of PBS. 

Fluorescence Microscopy 

1. Take images on a Zeiss Fluorescent Microscope (Imager.M1) equipped with an Axiocam MRm 

monochrome camera through the AxioVision software. 

2. Use the 20x objective (Zeiss Plan-NEOFLUAR 20x/0,05) and the DAPI channel to locate 

polytene chromosomes on the slide. 

3. Once finding a suitable location, use the 40x objective (Zeiss EC Plan-NEOFLUAR 40x/0,75 Ph2) 

to take pictures in AxioVision (6D Acquisition tool). When capturing images, ensure that the 

focus is adjusted to maximize the clarity of the banding pattern in the chromosomes. The 

specific value of the exposure time for the DAPI image not significant – choose whatever 



22 
 

exposure time is suitable for the chromosomes being examined. 

4. Use the Cy3 channel at the same location to view the Alexa 594 signal from the labeled RNA. 

All pictures in the Cy3 channel need to be taken at the same exposure time (999ms) in order for 

valid comparison across slides. 

5. Export the images of each color channel separately and in TIFF format for highest resolution. 

6. For each slide, take pictures of at least fifteen, ideally twenty, separate locations. 

ImageJ 

1. Each Cy3 channel image will be analyzed in ImageJ (Fiji). Before any processing, chromosome 

maps (Figure 3) must be consulted to identify each chromosome in the image. Labels were 

added for other lab members to double check chromosome identifications.  

2. Open the Cy3 image in ImageJ. Draw a straight line segment along the width of the widest 

visible object (band) in the image. Find the length of the drawn segment through Analyze > Set 

Scale and reading the Distance in pixels value. After noting the value, select Click to Remove 

Scale and press OK (all measurements will be taken in pixels). 

3. Use the pixel value rounded up to the nearest ten as the Rolling ball radius in Process > 

Subtract Background (no boxes checked in menu). 

4. Create a selection around regions of signal using Image > Adjust > Threshold (check Dark 

background). Select the “Triangle” auto-threshold option. The selection will by highlighted in 

red. 

5. Clean up the selection area by using Process > Noise > Despeckle. 

6. Use Process > Morphology > Gray Morphology to bring up the Morphology window. Set the 

radius of the structure element to 1.0 pixels, the type of structure element to circle, and the 

operator to dilate. This should help piece together rough selections over the bands. 

7. Use the Process > Smooth function to help solidify the bands. 
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8. It may be necessary to use the freehand selection tool to separate threshold areas into 

distinct bands by deleting the highlighted connection. Consult the original Cy3 to see if any 

single bands were combined together on the red selection map. 

9. In Analyze > Set Measurements check the boxes for Area, Mean gray value, and Centroid in 

the upper section. Also check Display label in the lower section and set the Decimal places to 3. 

10. Use Analyze > Analyze Particles to collect the measurements just defined for the areas 

contained in the threshold. Set the size to 2-Infinity Pixel units, 0.00-1.00 Circularity, the Show 

option to Outline, and check the boxes for Display result, Clear results, and Include holes. 

11. Two new windows open, one containing a table of measurements and the other an image 

with the outlines of the areas measured. Refer to the chromosome maps again to identify which 

specific locus each selection corresponds to.  

12. Save these two files to keep records of the area and the mean grey value to calculate the 

sum of the intensity (to be used for potential future qualitative analysis). Note down the 

chromosome loci where measurements were taken using the following qualitative scale: strong 

– complete band/structure, moderate – partial band/structure, little – little to no signal through 

ImageJ but visible in original Cy3 image. 
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Results 

Image Capturing & Chromosome Identification 

 The present study targets five different larval stages: early eyespot (EES) – 8x4 or 

smaller, 10x5, 12x6, 14x7, and edge eye (EE). Click-iT™ experiments were repeated until at least 

three biological replicates were accumulated for each stage. A single biological replicate was 

judged valid if the chromosomes retained good morphology and banding pattern, the Cy3 signal 

was visible, and there were three of each individual chromosome across all the images taken of 

the slide – in effect, three technical replicates per biological replicate. All images taken from a 

slide were examined, labeling all usable chromosomes, and chromosome counts were 

generated to ensure the replicate minimums were completed. The quality of the spread and the 

chromosomes themselves were the main factors affecting the number of images or usable 

chromosomes per slide. 

Analysis of Puffed DNA Puff Loci 

 Comparison of RNA synthesis at DNA puff loci in relation to visible cytological puffing 

could offer insight into transcription patterns that occur after amplification. Seven slides of the 

fifteen total contained chromosomes with obvious puff structures: one 12x6, all three 14x7, and 

all three EE. 12x6 is the stage where puffing typically starts. The puffs reach maximal expansion 

at 14x7 and then may structurally recede slightly in the EE stage. Only Chr II and Chr III had 

easily discernable puff structures, limiting this discussion to four major DNA puffs: II/2B, II/9A, 

III/10A, and III/11A. All chromosome portraits in this section feature a set of three images taken 

through different excitation channels. The DAPI channel shows stained DNA, colored blue in the 

combined image, and the Cy3 channel shows red signal from the incorporated EU at active 

transcription sites. 
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Figure 8. Fluorescent images of chromosome II: visualization of EU uptake with Alexa Fluor 594 (Cy3 - red), 

counterstained with DAPI (blue) – brightness and contrast have been altered for viewing purposes 
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Figure 9. Fluorescent images of chromosome III: visualization of EU uptake with Alexa Fluor 594 (Cy3 - 

red), counterstained with DAPI (blue) – brightness and contrast have been altered for viewing purposes 

 While there was only one 12x6 sample with DNA puffs, there are still several interesting 

observations to note. DNA puff II/9A predominantly has very little diffuse Cy3 signal in the puff 

as outlined in the DAPI channel (Table 2); this is expected since previous studies show that 

transcription at this locus mainly occurs at the 14x7 stage. However, there are two instances of 

RNA transcription closer to the original chromosome body within the puff (Figure 8h). One 

hypothesis for this occurrence is that the visible transcription is from genes that are not 
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replicated in the puff but are located near the amplicon and are occluded by the structure. On 

the other hand, at DNA puff II/2B there is diffuse signal in the Cy3 channel that shades in the 

entire puff structure in the DAPI channel, perhaps even extending farther out (Figure 8i). The 

diffuse signal indicates that the genes in the II/2B amplicon are transcribed at the 12x6 stage, 

earlier than II/9A. DNA puffs III/10A and III/11A on Chr III are also present in this 12x6 slide. They 

both have diffuse signal in the Cy3 channel coloring the entire structure of the puff, like II/2B 

(Figure 9i). 

 In the next developmental stage, 14x7, DNA puff II/2B has little to medium diffuse Cy3 

signal throughout the entire puff structure (Figure 8l). In conjunction with the 12x6 Chr II 

images, transcription seems to continue through to this subsequent stage at a similar rate. 

However, DNA puff locus II/9A now shows Cy3 signal as well. Interestingly, the signal does not 

appear diffuse through the whole puff structure like in the other three puffs examined and 

instead takes the shape of a wide single band at one end of the puff structure (Figure 8k, l). This 

pattern occurs consistently (Table 2); it could mean that the high production genes are located 

only in the anterior part of the puff, or the genes within the amplicon have different timings 

during development and only transcription at this specific portion was captured in the one hour 

incubation window. For Chr III, DNA puffs III/10A and III/11A both show a little diffuse Cy3 signal 

across the entire puff (Figure 9k, l). These two puffs seem to follow the same trend as DNA puff 

II/2B with transcription of the amplicon starting at stage 12x6 or earlier and continuing into 

14x7. 

 The final developmental stage examined is edge eye, which occurs shortly before 

pupation. Most puffs do not show any significant signal (Table 2), but there are still several 

occurrences of transcription. RNA synthesis at DNA puff II/2B may continue to this final stage 

with a small amount of diffuse Cy3 signal still at the puff locus (Figure 8n, o). On the other hand, 
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there is no discernable or consistent Cy3 presence at the II/9A locus (Figure 8n), indicating that 

transcription there is contained to the 14x7 stage. DNA puffs III/10A and III/11A have sporadic 

levels of diffuse Cy3 signal in the puffs (Figure 9o) at varying intensities from medium to none 

(Table 2). It is difficult to determine whether transcription here is a consistent occurrence with 

only three biological replicates. 

Table 2. Observations regarding cytological puffing: observed characteristics tabulated by occurrence – 

diffuse refers to signal shading the entire structure as opposed the presence of the presence of a 

concentrated band. Diffusivity was broken up into two categories based on intensity of signal 

  Observations  

Stage Locus diffuse little diffuse diffuse + band banding only none chr body 

12x6 

II/2B 6 - 2 - - - 

II/9A - 4 - - - 2 

III/10A 4 - 1 - - - 

II/11A 4 - - - - - 

14x7 

II/2B 5 6 - - - - 

II/9A - 3 - 7 3 - 

III/10A - 6 - - 1 - 

II/11A - 4 2 1 1 - 

EE 

II/2B - 7 2 - 8 - 

II/9A - 2 - 1 10 - 

III/10A 2 2 - - 10 - 

II/11A 1 2 - 1 9 - 
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Figure 10. Fluorescent images of chromosome IV: visualization of EU uptake with Alexa Fluor 594 (Cy3 - 

red), counterstained with DAPI (blue) – brightness and contrast have been altered for viewing purposes 
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Figure 11. Fluorescent images of the X chromosome: visualization of EU uptake Alexa Fluor 594 (Cy3 - 

red), counterstained with DAPI (blue) – brightness and contrast have been altered for viewing purposes 
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Analysis of DNA Puff Loci Over Developmental Time 

 In this assay, one way to definitively determine if amplification and puffing have 

occurred at a locus is confirmation through visible puffing. However, looking at documented 

DNA puff loci that do not exhibit puffing could be informative of what sort of transcription 

occurs before amplification, specifically in the EES and 10x5 stage because amplification has 

either not begun or only just. There are eighteen DNA puff sites across all four chromosomes 

(Table 1) and they are shown labeled across all the developmental stages in the chromosomes in 

Figures 8-11. The following plots (Figures 12-15) display the distribution of EU incorporation 

over the entire chromosome at each developmental stage. Locations of signal were qualitatively 

rated strong, moderate, and little. These ratings were given corresponding numeric values – 2, 

1, 0.5 respectively. The collective ratings of three technical replicates were summed for each 

locus for a single biological replicate, and then the average of the biological replicates for each 

locus is plotted. 
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Figure 12. Distribution of EU signal in chromosome II: frequency and qualitative intensity weigh into the 

distribution – all DNA (boxed) and RNA (arrows) puff loci are included on scale regardless of whether 

signal was present or not (currently showing only one biological replicate) 

 In the pre-puff stages, several DNA puff loci on Chr II show significant amounts of signal. 

Locus II/14B seem to show the highest levels of activity in both the EES and 10x5 stages (Figure 

12). II/6A and II/13A are the next highest, with more moderate levels of EU incorporation. The 

only DNA puff locus that shows no signs of active transcription in both these two stages is puff 

II/2B, while there is also no signal from II/9A and II/11A only in the 10x5 stage. Puff II/2B seems 

to follow the pattern that has been determined biochemically for II/9A, with little to no activity 

in the earlier stages and a large spike at the 14x7 stage. Interestingly, this pattern is not 

obviously visible at II/9A in this study. While the largest presence of signal at the locus did occur 

in the 14x7 stage, there seemed to be some activity at the locus in the 12x6 and EES stage. 
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Additionally, there seems to be a contradiction to this transcription preceding amplification 

hypothesis in several locations with more signal in the earlier stages – DNA puffs II/14B, II/6A, 

and II/13A. Comparing these loci across all the developmental stages, the most significant 

amount of activity occurs in these early stages with subdued and potentially background levels 

of signal during the expected burst stage at 14x7. 
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Figure 13. Distribution of EU signal in chromosome III: frequency and qualitative intensity weigh into the 

distribution – all DNA (boxed) and RNA (arrows) puff loci are included on scale regardless of whether 

signal was present or not (currently showing only one biological replicate) 

 EU activity across the four DNA puff locations in Chr III is quite erratic. There seems to 

be almost no labeling in the EES stage in general, with few loci fluorescing and only a single DNA 

puff locus, III/15B, having slight signs of incorporation (Figure 13). Contrarily, there is no signal 

spotted from III/15B in the subsequent stage of 10x5, while III/10A and III/11A – the two 

structurally obvious puff loci on the chromosome – start to have signs of transcription. Signal at 

these two puffs lasts until the EE stage, at least at a very low level in the case of III/10A. Signal 

returns at a moderate level at III/15B in 12x6, showing a large level of fluctuation in these three 

stages. Interestingly, DNA puff III/2B in these profiles seems to follow the exact same pattern set 

by puff II/9A, with essentially no EU signal in any of the first three stages and having a relative, if 

modest, burst of activity at 14x7. With regards to a general developmental pattern of 

transcription, more EU incorporation is seen in the later stages of 12x6, 14x7 and EE. 
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Figure 14. Distribution of EU signal in chromosome IV: frequency and qualitative intensity (strong, 

moderate, or little) weigh into the distribution – all DNA (boxed) and RNA (arrows) puff loci are included 

on scale regardless of whether signal was present or not (currently showing only one biological replicate) 

 In Chr IV of EES stage larvae, there is a very low amount of signal in general and no 

signal at all at any of the six DNA puff loci on the chromosome (Figure 14). This overall subdued 
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level of activity continues into the 10x5 stage, but DNA puffs IV/10B and IV/15B start showing 

signs of EU incorporation. Subsequently at 12x6, puff IV/10B recedes while IV/15B continues at 

the same low level. The IV/8C locus also starts being active at this time. The three other puffs, 

IV/5C, IV/12A, and IV/19A all show no transcription during this assay until the 14x7 stage – again 

echoing the pattern proven for DNA puff II/9A. The only most constant presence of transcription 

amongst the DNA puffs is locus IV/15B which shows signal in 10x5 that continues through until 

the EE stage. 
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Figure 15. Distribution of EU signal in chromosome X: frequency and qualitative intensity (strong, 

moderate, or little) weigh into the distribution – all DNA (boxed) and RNA (arrows) puff loci are included 

on scale regardless of whether signal was present or not (currently showing only one biological replicate) 

 The EES stage X Chr also has very low to negligibly detectable amounts of EU 

incorporation (Figure 14). The level of signal ramps up in each of the subsequent stages, 

reaching easily visible levels. The two DNA puff locations on the chromosome, X/7A and X/11B, 

seem to exhibit activity for a large portion of the developmentally time examined. Activity is 

observed at the X/7A locus starting and peaking at the 10x5 stage and continuing to an almost 

undiscernible level in the EE stage. The X/11B locus displays a slightly more constant amount of 

signal from the 12x6 stage also to the EE stage. Both puffs do not seem to exhibit much activity 

in the pre-amplification developmental stages, but do not have a sharp spike of activity in a 

specific developmental stage. 

Analysis of RNA Puff Loci 

 RNA puffs can appear quite distinct from the typical DNA puff structure. The bulb 

protruding out from the chromosome body often is not fully visible through the DAPI channel 

used to view the full chromosome morphology, because DAPI only stains double stranded DNA. 

The full puff can be seen however by visualizing the large amount of RNA contained inside 

through the Cy3 channel. The location of the RNA puffs typically coincides with large non-

staining or darker regions in the chromosome banding pattern. Several prominent RNA puffs are 

II/2B (Figure 8f, 8l), II/BC (Figure 8i), and III/9B (Figure 90) – at these loci there is a wide band of 
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signal from EU incorporation that extends slightly wider than the body of the chromosome. The 

manifestation of physical RNA puffs does not only occur in later developmental stages like DNA 

puffs. For example, RNA puff IV/9C (Figure 10c) is visible in the EES stage. Additionally, some 

puffs are not restricted to a single developmental stage. RNA puff III/5C exhibits puff-like signal 

at the EES (Figure 9c), 10x5 (Figure 9f), and EE stages (Figure 9o). 

Surveying the entire collection of distributions of signal in the chromosomes, all RNA 

puff loci (Table 1) display signs of EU incorporation in at least one of the developmental stages – 

there are no loci for which signal was not seen for the entire developmental spread covered by 

the present study. In fact, not only is there signal present at all RNA puff loci, every location 

reaches a moderate rating within the distribution – at least a 4 – except for several RNA puffs on 

the X chromosome: X/4A, X/4B, X/14B, and X/14C. Despite the common presence of label 

incorporation, the peak timing – here thought to be the earliest spike – of signal differs amongst 

the puffs, though very few occur during the EES stage. The RNA puffs that appear most 

significantly in the present study are II/10BC, II/12A, II/13C (Figure 12), IV/4C, and IV/19C (Figure 

13). All these loci attained a maximum value of 6 in the distribution. Interestingly, all of these 

peak values were observed in the 14x7 stage. 
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Figure 16. Summary of EcR-A binding across the genome: green indicates sites of EcR-A binding, yellow 

text in black box denotes DNA puffs, red text indicates RNA puffs, black text indicates prominent EcR-A 

orphan signals, yellow underline indicates EU incorporation, arrows indicate loci of EU incorporation but 

no EcR-A binding (Liew, Foulk et al. 2013) 

EcR-A Maps Comparison 

 A study by Liew et al. in 2013 mapped where the ecdysone receptor binds to the three 

autosomes of Sciara. These maps were created by immunostaining with an antibody for the 

most common isoform of the ecdysone receptor in Sciara, EcR-A. The immunostaining 

experiments were completed for the same developmental stages that the present study has 

focused on. These maps depict several different association trends between EcR and the 

chromosomes (Figure 16). Most notably, EcR associates with all DNA puff loci and binds to most 

RNA puff sites. In the 10x5 stage there is generally immunostaining at all the major and minor 

DNA puff loci, and this coverage continues through to the 14x7 stage. Conversely, only seven 

puff loci show EU incorporation at this stage: II/13A, II/13A, III/11A, IV/8C, IV/10B, and IV/15B. 

However, by the 14x7 stage, signs of active transcription at all the puff loci can be seen at all of 
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the puff loci as well. Similarly to the DNA puff loci, EcR-A immunostaining at the RNA puff loci is 

also seen in the 10x5 and 14x7 stages. On the other hand, RNA synthesis is not labeled at several 

RNA puff loci in the 10x5 stage, namely IV/5B, IV/9C, IV/10C, and IV/19C, and again reaches the 

same coverage as the EcR-A signal in the 14x7 stage at these loci.  

Interestingly, two strong immunostaining signals consistently observed across 

development that do not correspond to any puff loci, termed orphan signal, at II/4A and III/13C 

have different levels of EU incorporation. II/4A has a low to moderate presence of signal 

between EES and the 12x6 stage, while the other signal at III/13C only shows low presence of 

transcription at the EE stage. Overall, EcR-A staining and EU incorporation is observed at some 

level at the majority of loci across the chromosomes, with EcR-A a more prevalent presence. In 

the 10x5 stage, only three loci showed EU incorporation with no EcR-A binding on Chr II and Chr 

III. Chr IV had seven such loci, and the disparity increases at the 14x7 stage for Chr IV and Chr III, 

with twelve and four loci with EU but no EcR-A signal, respectively. 
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Discussion 

 The present study is an investigation of RNA synthesis in salivary gland polytene 

chromosome, with a focus on looking at locations of high relative activity from the limitation of 

a one hour EU incubation window. Signal from EU incorporation is mainly observed in the non-

staining (dark colored) interchromomeres. This observation is expected because 

interchromomeres are regions of less condensed chromatin, or euchromatin, that alternate with 

more condensed stretches to form the representative banding pattern of the chromosomes. The 

less tightly packed state of euchromatin makes the genomic DNA more accessible, which 

facilitates the progress of any synthetic activity within the chromosome. A single previous study 

has examined RNA metabolism of salivary gland nuclei using autoradiography of incorporated 

tritiated uridine (Gabrusewycz-Garcia and Kleinfeld 1966). The present study corroborates 

several findings from this previous work, including a significant amount of variability in the 

general amount of RNA metabolism amongst individual larvae. The general levels of EU 

incorporation typically seem to show characteristic differences at different developmental 

stages. For example, many loci exhibit the most activity at the 14x7 stage, and then signal peters 

off to a much lower level in the subsequent EE stage. Additionally, RNA puffs do generally show 

relatively higher amounts of EU incorporation. In comparison to the previous research, the 

present study provides well-staged data that could even lend itself to quantitative methods to 

fill any gaps in the 1966 study. 

 Patterns of EU incorporation vary greatly across the DNA puff loci. There are several 

puffs that exhibit a pattern similar to what has been biochemically determined for DNA puff 

II/9A, where amplification precedes transcription that primarily takes place in the 14x7 stage. 

These puffs include II/2B, III/2B, IV/12A, and IV/19A. Several puff locations, only on Chr II, 

display the largest amount of activity before the 14x7 stage -- namely puffs II/6A, II/14B, and 
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II/13A. There are also even two loci that peak later than 14x7 in the EE stage in DNA puffs III/15B 

and IV/15B. The temporal burst of transcription model does not necessarily fit all of the puff loci 

either, with several DNA puffs, such as III/10A, III/11A, and IV/8C, exhibiting more stable levels 

of signal across the developmental stage. The developmental stages defined in the present 

study are qualitative bins that cannot study transcription timing in a perfectly synchronous 

setting, but there still does seem to be evidence that different transcriptional patterns exist 

amongst the DNA puff loci in Sciara. 

Another interesting angle to consider in this assay is where in the structure of the puffs 

signal was detected. For some puffs, the signal appears in a diffuse manner that colored the 

entire of the puff seen by DAPI staining. For others, there are occasionally single or multiple 

bands that could be individually identified within the puff structure. The observation of these 

two different labeling patterns creates a strange conundrum regarding where the genes in the 

amplicon are located inside the puff itself. Previous in situ hybridization with a 1kb probe 

complimentary to a portion of the origin of replication at DNA puff II/9A resulted in a diffuse 

signal, possibly indicating that copies of the amplicon are spread out through the entire puff 

structure rather than having certain segments belonging to the anterior or posterior portions 

(Yamamoto, personal communication). This finding suggests that the individual bands visualized 

in the puffs correspond to genes that are not contained in the amplicon but have been occluded 

into the general puff structure. This happens quite regularly, as the amount of re-replication is 

to such a degree that it cannot be contained in a single band. For example, examination of the 

puff structure of DNA puff II/9A showed that five bands in total are covered by the puff itself 

(Crouse and Keyl 1968). 

 RNA puffs are also loci of interest in the present study. Historically they were referred to 

as “bulbs” and characterized as conspicuous non-staining areas (Gabrusewycz-Garcia 1964). 
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Some of these structures have been noted to be constant cytological landmarks throughout 

development, while others restrict their appearance to certain stages. The name RNA puff has 

been attributed to the more constant bulbs documented in previous cytological studies. The 

fickle nature of the RNA puffs is certainly experienced in the present study as it is often difficult 

to reliably determine whether or not an RNA puff loci has puffed. The appearance of physical 

RNA puffs is also not as easily observed as the manifestation of the DNA counterparts because 

they are much smaller in size. Regardless of physical puffing however, transcriptional activity is 

still detected at all RNA puff loci examined at some point in development. The peak activity 

timing across the RNA puffs varies greatly, although the puffs that display the most significant 

levels of signal all peak in the 14x7 stage. Additionally, there is RNA sequencing data available 

from salivary gland chromosomes. Initial inspection of this data provides some suggestions as to 

where RNA puffs are, but in situ hybridization to correlate sequences with specific puffs is 

necessary to methodically compare the RNA sequence data with this RNA synthesis labeling 

assay. 

 The purpose of comparing EcR-A binding and locations of active transcription is to see if 

the ecdysone receptor could potentially have a role in inducing transcription in that specific 

region. EcR signal in the chromosomes in general grew with developmental time, both in 

number of locations and brightness of each instance. With regards to broad developmental 

trends of EU incorporation, there is no clear progression in number of loci or intensity. Speaking 

very generally, the EES and EE stage have the smallest amount of signal with the exception of 

EES Chr II which shows a significant amount of activity. Comparing the locations of signal 

between EcR immunostaining and the RNA synthesis labeling, the majority of loci with EU 

incorporation are locations of EcR binding as well. There are several regions, especially on Chr 

IV, where RNA transcription appears to occur without EcR binding. This would suggest that not 
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all sites of transcription may be correlated with ecdysone. However, a dual labeling experiment 

with specificity for the receptor and transcription would be necessary to more precisely discern 

where the two phenomena do and do not overlap, especially at the specific banding level. 

 Coming back to one of the main questions the present study set out to answer: when 

does active transcription occur with respect to DNA amplification? The results from the previous 

mapping of RNA puffing and transcription suggested that transcription occurs somewhat 

simultaneously with amplification (Gabrusewycz-Garcia and Kleinfeld 1966). There is no clear 

divide in terms of transcriptional timing or magnitude in the present study with regards to the 

developmental stages and the progress of developmental DNA amplification associated with 

each stage; this would also somewhat suggest that transcription generally occurs simultaneously 

with amplification, at least to a slight extent. None of the distributions of EU incorporation 

across the chromosomes display a stark or reliable change in behavior at a single developmental 

turning point. The closest replication of a clean pattern is at DNA puff II/2B where no signal is 

observed in either the EES and 10x5 stage before displaying strong signal at 14x7. There are also 

a few examples of DNA puff loci exhibiting the most activity in the earlier stages of EES and 

10x5, such as II/14B, contrary to the hypothesis of amplification preceding transcription. 

However, these are not isolated bursts as transcription at these loci continues through to later 

stages. With regards to presence of transcription in comparison to cytological puffing, in other 

words after amplification, EU incorporation is observed at DNA puff loci II/2B, II/9A, III/10A, and 

III/11A. The lack of a clear distinction may be due to focusing on this question at a single 

chromosome level, as compared to the average of many genomes when conducting biochemical 

experiments where differences would be amplified due to the much larger sample size. 

 Secondly, are all highly transcribed genes amplified? The results of the present study 

would suggest that not all highly transcribed genes are contained in puff amplicons. In the 
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comparison of EU incorporation with cytological puffing, there are several intense bands of Cy3 

signal that are contained to the normal condensed body of the chromosome and do not 

correspond with DNA or RNA puff loci (Figure 8, 9). The existence of RNA puffs themselves 

indicate that there are loci involved in robust transcription and puffing without amplification. 

The distributions of EU incorporation also suggest that highly transcribed genes are not always 

involved in puffing. Several non-puff loci reach the high level of signal (a qualitative 6) seen at 

puff loci, such as II/14C, III/8C, IV/18C, and IV/19B. However, the majority of non-puff loci do 

have lower levels of EU incorporation in general as compared to most RNA puffs and some DNA 

puffs. 

 Finally, are all amplified genes highly transcribed? From the comparison with the 

cytological puffing, II/2B, III/10A, and III/11A all have diffuse signal that encompass the whole 

puff, seeming like all of the genes contained in the puff are transcribed. But, for II/9A, only one 

part of the puff has transcription signal at the 14x7 stage. Since the entire puff does not have 

Cy3 signal, this could suggest that there are amplified genes at the II/9A locus that are not being 

highly transcribed. Or, if the transcription seen there is from genes not amplified but occluded 

by the puff structure, it is possible that this one hour incubation period missed the expected 

transcriptional burst at the 14x7 stage at this locus, so no strong signal is observed.  

From the EU incorporation distributions, the amount of transcription detected at DNA 

puff loci varies greatly. Some of the loci with the most consistent and strongest signal are DNA 

puffs, but other DNA puffs show significantly less. To answer this question, it needs to be 

determined if the mere presence of EU incorporation from a one hour incubation is enough to 

qualify a locus as highly transcribed. None of the Cy3 signal from the images appear 

oversaturated, so it is unlikely that information about the higher levels of transcription is lost by 

comparing brightness. On the other hand, it is unknown what background levels of transcription 
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would look like in this assay. If background transcription occurs too slowly or in too little volume 

to be captured by the limited incubation period, then the present study would be a suitable 

method in locating regions of high transcription. However, if background transcription is visible 

through the assay, then a method in categorizing high transcription signals from background 

would be necessary. 

 A number of difficulties were encountered in the present study. When identifying loci 

on the X chromosome in the images, the banding pattern was not as clear as the other 

chromosomes because of the X’ inversion and triple repeat regions that often do not retain 

good morphology after squashes (Gabrusewycz-Garcia and Kleinfeld 1966). Additionally, a full 

set of maps across different larval developmental stages were not available for the X 

chromosome; it seems that regions 15 through 17, where RNA puffs have been identified, were 

not included on the map at all. Another difficulty related to processing the images was the high 

level of Cy3 background in many of the pictures. The high amount of background made it more 

difficult to measure the extent of EU incorporation because the images were low contrast and 

the RNA bands did not stand out as much as they could have. There has been research into 

reducing background in click chemistry labeling reactions using azidocoumarins as the labeling 

reagent (Ishizuka, Liu et al. 2016). Azidocoumarins are pro-fluorophores, where the azido group 

natively quenches fluorescence and the click reaction is needed to remove the azide group to 

stop the quenching. The labeling reaction with this labeling scheme removes background 

effectively because unbound fluorophores would not fluoresce, potentially even removing the 

need to perform additional washes. 

 Inherent limitations to this form of labeling and microscopy experiments in general are 

that the technique gathers data from a single specimen at a time and relies on manual 

identification. Especially when trying to implement quantitative methods, a large sample 
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population is preferred to account for individual variation. With three biological replicates, 

larval, chromosome, and experimental variation all would have noticeable effects on the results. 

Manual identification is a characteristic that limits using cytological data to provide insights into 

molecular processes; it is difficult to locate loci precisely by eye, as compared to the accuracy 

that molecular studies provide for. Also with this microscopy technique, there is little way to 

confirm that what signal seen at a locus originated from that spot exactly, rather than migrating 

over from a separate location. Despite these challenges, the pinpoint specificity of examining 

replication and transcription at the single chromosome level still provides many details unable 

to be answered by biochemical studies that average many genomes. Instead of glossing over 

variation via a high sample population, cytological studies can learn about, and study within, the 

biological variation without the loss of any information. 

 The method of data collection in this present study is a suitable set up for performing 

quantitative analysis on the signal intensities from the site of EU incorporation. The mean of the 

technical replicate score could serve as a sample mean to lead into the statistical calculation of 

the population means and standard deviations of the biological replicates. Additionally, two 

other concrete improvements to the study that could be implemented immediately are 

instituting a negative experimental control as well as considering different time points for the 

EU incubation. A negative control is key in trying to ascertain that the signal given off by the 

Alexa fluorophore is in fact connected to RNA transcription. RNAse could be added to the slide 

after the EU incubation to destroy new transcripts – if fluorescent signal was still seen through 

the Cy3 channel on the chromosomes that would indicate that the reaction is not specifically 

occurring at sites of RNA transcription. The duration of the EU incubation also has not gone 

through any sort of optimization, as it was recommended by the kit manual. Examining different 
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time points may be helpful in studying the rate of transcription as well as finding the optimal 

period of time to capture the most informative snapshot of transcription at amplification loci.   

 Originally, the present study aimed to compare the chromosomes of the anterior and 

posterior portions of the salivary gland. Several puffs only appear in chromosomes from one of 

two partitions (Table 1). If the DNA puffing pattern between these two halves of the salivary 

glands is different, it would be interesting to see if there was any difference in transcription 

pattern as well. The anterior polytene chromosomes also undergo an additional round of 

endoduplication, setting them a degree further apart from the rest of the salivary gland 

chromosomes. However, there are fewer cells in the anterior part of the gland and, accordingly, 

fewer chromosomes, leading to more difficult squashes to reliably have at least three of all four 

chromosomes visible and with good morphology. The squash method itself may need to be 

optimized in a different manner for spreading the anterior chromosomes. The stringency 

requirements for quantitative data collection potentially may also need to be reexamined to 

collect data from the anterior portion. 

 
Figure 17. Inverse electron demand Diels-Alder cycloaddition: click reaction between 5-vinyl-2’-

deoxyuridine and a tetrazine-fluorophore 

Comparing active RNA transcription to morphological structures on the chromosome is 

informative about the relationship between amplification and transcription, but only to a certain 
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extent. A truly productive study to explore the relationship would be to examine active 

transcription and replication simultaneously in the same sample. The present study utilizes the 

CuACC click reaction between alkyne and azide groups, but this is not the only click reaction that 

has been used for labeling in biological systems. The inverse electron demand Diels-Alder 

(invDA) cycloaddition (Figure X) has been implemented in vivo using 5-vinyl-2’-deoxyuridine 

(VdU) as the metabolic moiety and a tetrazine tagged fluorophore as the visualizing agent in the 

standard pulse-chase experiment scheme to visualize DNA replication. The invDA and CuACC 

reactions are completely chemically orthogonal and are able to specifically occur to label DNA in 

a sample (Rieder and Luedtke 2014). While there have been no examples of simultaneous DNA 

and RNA synthesis labeling, there has been progress on the industry side of research towards 

producing widely available VdU and tetrazine imaging systems for the purpose of dual labeling 

and provide an alternative to the progenitor CuACC click imaging set. Jena Bioscience is one 

such company working to develop VdU products, making this proposed extension to the present 

study a possibility for the not so distant future. In the meantime, another company, Genomic 

Vision, is working with Jena Bioscience to pioneer DNA and RNA synthesis labeling for genetic 

combing (personal communications). 
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